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Contents 

Upon completion of this class, you should be able 
to: 

? Recognize a spreadsheet 
? List some common uses for spreadsheets 
? Identify the parts of the Microsoft® Excel window 
? Create an Excel workbook 
? Enter data into Excel 
? Edit cell data 
? Save an Excel workbook 
? Open an Excel workbook 
? Select cells  
? Use the AutoSum function 
? Format cells using text formatting and simple number 

formatting 
? Cut, copy and paste  
 

Additional Resources: 
The library has many books on Microsoft® Excel and other 
spreadsheet software.  Look in call numbers 005.369 and 
650.0285 for books about spreadsheets. 
Most libraries will also have this handy book in the reference 
section (R005.369) for you to use while in the library: 
Teach Yourself Microsoft Excel 97 Visually (or Excel 2002 Simplified ) 
by Ruth Maran  
For other technology workshops & programs being offered at 
the library check: http://www.plcmc.org/programs 
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Spreadsheets 

An electronic spreadsheet is the modern equivalent of three 
familiar bookkeeping tools: the paper ledger, pencil and 
calculator. 
If you have ever done bookkeeping the non-electronic way, you 
may be familiar with some of the challenges: filling out and 
making corrections on the ledger sheet; calculating totals, 
averages, maximums and minimums; recalculating these values if  
one numeric entry changes; redesigning the ledger to add or 
delete columns or rows; and preparing the ledger for 
presentation. 
Electronic spreadsheets, such as Excel, eliminate or reduce the 
difficulty of such tasks. 

Spreadsheet software 
n Microsoft® Excel 

n Lotus 1-2-3 

n Quattro® Pro 

Who uses spread-
sheets 
n Businesses 

n Scientists 

n Accountants 

What Excel can be 
used for 
n Listing addresses and 

phone numbers 

n Managing checkbook 
register 

n Tracking home budgets 

n Tracking weather 
trends 

n Listing books to read 
or that you have already 
read 
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The Excel window 

A window is a rectangular area on the screen through which you 
view a computer program or application. After starting Excel, 
you see two windows, one within the other. The outer window is 
called the application window, and the inner window is called the 
document window.  
When you open Excel, Excel creates a single new file named 
“Book1.” This file, also called a workbook, contains three 
worksheets named “Sheet1,” Sheet2” and “Sheet3.” To move 
from worksheet to worksheet, click on the worksheet tabs or use 
the arrows to the left of the tabs. 
An Excel worksheet is an electronic version of a paper 
spreadsheet, containing horizontal rows and vertical columns. 
Letters running across the top of the worksheet designate 
columns, and numbers running down the left side of the 
worksheet designate rows. 
The intersection of a column and a row is called a cell. Data is 
entered directly into any cell that is active. A thick, dark border 
identifies the active cell. 
 
 
       

Windows 
n When you close the 

inner window, you are 
closing the file or 
workbook. 

n When you close the 
outermost window, you 
are closing Excel. 

A single worksheet 
contains 
n 256 columns 

n 65,536 rows 

n Over 16 million cells 

n Each cell can contain 
up to 255 characters 
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The Excel Window 
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Opening your workbook 

1.  Click on the Open button on the standard toolbar or use the 
menu command File, Open.                          

File extensions 
n A file extension tells 

Windows what 
program to use to open 
a file. 

n Excel uses .xls as its file 
extension. 

n Each computer 
program has its own 
file extension 2.  The second step is to tell the computer where the file is 

located. Tell the computer to look in the floppy disk (3½ 
Floppy A:) location.  To do so, click on the drop down arrow 
and select 3½ Floppy A: 

3. Select the file that you would like to open by clicking on the 
file name with the mouse. Hint:  If there are no files listed 
make sure that the files of as type selected is Microsoft Excel 
Files. 

4. The last step is to click the Open button. 
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Exercise 1: Navigation 

1.  Launch Microsoft Excel by clicking the Start button with 
your mouse. Then select Programs, MS Office, Microsoft 
Excel. (Look for the green icon.) 

2.  Open the workbook entitled “Example” using the file menu, 
open command. 

3.  Look at page four of this handout and try to find as many of 
the Excel window components as you can. 

4.  Explore the functions of the buttons on the toolbars by 
viewing the ToolTips. Position the mouse cursor over a 
button, but don’t click. Wait two to three seconds. A yellow 
box will appear that describes the function of the button. 

5.  Use your scroll bars to move down to the end of the 
worksheet and then back to the beginning. 

6.  Use your mouse to move from cell to cell. 
7.  Use the arrow keys on your keyboard to move from cell to 

cell.  
8. Return to cell A1 by pressing the Ctrl key and the Home key 

at the same time. 
9. Click on the Budget tab and then on the pie chart tab to view 

other “sheets” in this workbook. Practice moving around 
these worksheets. 

10.Close the file using the File menu, Close command. If asked, 
do not save the changes to the workbook. 

 
 

Help! 
n Microsoft® Excel has 

extensive help files 
built in to assist you 
with using the product. 

n Just click on the Help 
menu and select 
Contents and Index.  

n You can also press F1 
on the keyboard to 
bring up Help.  
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Entering and editing data 

In Excel you can enter values (numbers) or labels (text) by typing 
directly into a selected cell. The default alignment is right for 
numbers and left for text. To tell Excel to accept the data, you 
must either press the Enter key, click on a cell other than the one 
into which you are entering data, or press one of the directional 
arrow keys on the keyboard. 
Change cell contents by first selecting the cell to be edited, then 
make corrections in the formula bar. When you are finished 
making the correction, press the Enter key on your keyboard. 

 
“Golden Rule” of 
Excel 
Creating a basic 
spreadsheet in Excel is a 
breeze. The principal rule 
to follow when creating 
spreadsheets is to focus on 
getting the content of the 
data in first, then go back 
and apply formatting. In 
other words, make sure 
your data is correct before 
you make it look pretty. 

 

Note that you could simply select the cell and type in new data; 
however, when the cell contents are long and/or complex, it is a 
time saver to use the formula bar to make adjustments. 

Tips 
n Cells in a spreadsheet are given “addresses” instead of 

names. A cell’s address is its column letter followed by its 
row number. The first cell — the cell in the upper left 
corner — is given the “address” A1. The cell to its 
immediate right is B1. The cell below it is A2. 

n When entering data for the first time or when editing data, 
you must move to another cell before the worksheet will 
show the changes. 

n To move to a different cell, you can press the Enter or 
Tab keys on the keyboard or use the mouse to click on 
another cell. The tab key will move you to the next cell to 
the right. Holding the shift key while you press tab will 
move you to the next cell to the left. 

 
 

Formula bar 
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Saving your workbook 

1. Click the Save button on the standard toolbar or use the 
menu command File, Save. 

3 ways to save 
n Click the Save 

button on the 
standard toolbar. 

n Use the File menu and 
click on the Save 
button. 

n Use the Ctrl + s 
keyboard shortcut. 

Save As 

The Save As command can 
only be found on the File 
menu. The Save As 
command allows you to 
save your work to a 
different location or with a 
different file name. This 
can be useful if you want to 
save different versions of 
your file. 

Save vs. Save As 

Here’s a tip to help you 
remember the difference 
between Save  and Save As: 

n Save = 1 word and 1 
file 

n Save As = 2 words and 
2 (or more) files  

2. The second step is to tell the computer where you would like 
to save the file. By default, at the library, the computer will 
save to the C:\temp location.  You need to tell the computer 
that you want to save to the floppy disk (3 ½ Floppy A:)  To 
do so, click on the drop down arrow and select 3 ½ Floppy 
A: 

3. Type in a name for the file in the box for File name. Addi-
tionally, make sure that the save as type is Microsoft Excel 
Workbook. 

4. The last step is to click the Save button. 

2 

4  3  
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Selecting cells and AutoSum 

The AutoSum button is a quick way to add numbers. But first 
you must know how to select cells.  

Selecting cells 
Selecting cells involves clicking and dragging the mouse.   
1. Put the mouse in the top left corner of the area that you want 

to select. 
2. Click and hold down the left mouse button and drag the 

mouse to the lower right corner of the area that you would 
like to select.  Hint: Read the notes in the left margin to 
understand how to tell what areas have been selected. 

AutoSum 
The easiest way to add a group of numbers in a table format is 
to select all of the values and all of the empty cells where you 
would like the totals to appear.  Then click the AutoSum button 
located on the standard toolbar. 
For example, selecting these cells: 

Tips for Selecting 
Cells 
When you select a group of 
cells, the cells will appear 
highlighted in the opposite 
color of the background.  
If the background of your 
cells is white, the cells will 
appear as black. 

The exception to this is the 
first cell that you selected.  
This cell will always remain 
its original color so that 
you can tell which cell was 
the cell that you began 
with.  The black border 
that usually surrounds the 
active cell denotes the first 
cell that you selected. 

 

AutoSum Tip 
The AutoSum button is 
located on the standard 
toolbar and looks like a 
squiggly E. (It’s actually the 
Greek symbol Sigma, or S .) 
 
 
 
 

Then clicking AutoSum, gives this result: 
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Exercise 2: Creating a simple 
worksheet 

1. Create a new workbook by clicking the New button 
on the standard toolbar. 

2. In cell A1, enter the title of the worksheet, “Budget 
1st Q.” 

3. Enter the rest of the data as displayed in the example below. 
4. Save the workbook by clicking the Save button on the 

standard toolbar. Name the file “My Budget.” Remember to 
save the file to your diskette (3½ Floppy A: Drive).  

5. Use AutoSum to calculate the totals in E4, E5, E6, B7, C7 
and D7. Save your work again. 

6. Now close Excel. Then open Excel and open the workbook 
you just created. 

More saving tips 
n One of the benefits of 

using an electronic 
spreadsheet program is 
that you can save your 
work and come back to 
it at a later time.  

n When using any 
program, it is a good 
idea to save your work 
about every 10 minutes.  

n Unexpected events like 
power outages or 
computer problems can 
cause your system to 
reboot or “lock up.” If 
this occurs, any work 
that you have done 
since your last save will 
be lost. 

n At the library it is also 
important to save your 
work to a 3½ floppy 
diskette and not to the 
computer’s hard drive. 
Utilities have been 
installed on the 
computers that will 
delete all files from the 
hard drive whenever 
the computer reboots 
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Editing your spreadsheet 

As you work with spreadsheets, you will need to change data, 
delete and add it. 
To change existing data, select the cell where you need to 
make changes. Then type your changes into the formula bar. 
To delete data in a single cell, highlight it and press the Delete 
key on your keyboard.  
To delete data from an entire range, select the range and press 
the Delete key. (See page 13 for a definition of range.) 
To add an entire row, select the row below where you want the 
new row to appear, and select the Insert menu, then Rows.  
To add an entire column, select the column to the right of 
where you want the new column to appear, and select the Insert 
menu, then Columns.  
To delete an entire row or column , select the row or column 
by clicking the row or column heading. (Refer to page 5 if you’ve 
forgotten where the headings are.) Then select Edit, Delete.  
If you select a group of cells instead of the entire row or 
column, you will be asked what should be done with the rest of 
your data:  

In this lesson, we will focus 
on techniques you can use 
to modify your worksheets. 
Many of these commands 
come from the Edit menu. 
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Formatting cells 

Once you have entered data into a spreadsheet, you may want to 
make some visual changes to make the data more readable.  
Select the cell or range of cells that contain the data you want to 
format, and click the appropriate formatting button on the 
toolbar. For example: 
1.  Select the cells in the range B3:E3 

What’s a range? 
Many of these techniques 
can be applied to a range of 
cells. In a spreadsheet, a  
range is any group of cells 
that touch each other. A 
range is always referenced 
this way — A3:E7 — 
where the first cell address 
is the top left cell and the 
second cell address is the 
bottom right cell. 

Remember undo! 
Don’t forget that you can 
use the Undo button if you 
make a mistake! It 
magically undoes what you 
just did, and is a great way 
to save yourself if 
something you accidentally 
hit made all your data 
disappear. 

2.  Click the Bold formatting button, and then click somewhere 
on the screen but outside of highlighted cells.  

Notice that the data in B3:E3 is now in bold. Use the same 
method to apply any of the formatting in the toolbar.  
To remove formatting from selected text, click the formatting 
button again. 
Note: To apply font changes and other formatting to the text in 
an individual cell, first select the cell. Then highlight the text in 
the cell — either by double-clicking the cell or in the formula 
bar — and make your changes. Click Enter to see your changes 
on-screen. 

Tip 
You can quickly select an 
entire row by clicking the 
row number/row heading. 
Select an entire column by 
clicking the column letter/
column heading.  
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  Use the same steps to apply any of the formatting options on 
the toolbar. Most will be familiar, although there are a few that 
may be new to you. 

Merge and Center or Center Across Columns will center 
the contents of a cell across multiple columns.  

This is not the same as Center Align, which, 
with left align and right align, controls the 
position of text within a cell.  

Currency format displays numbers as currency. For 
example, 1234 becomes $1,234.00. 
Percent format displays numbers as percentages. For 
example, 1234 becomes 123400%. 
Comma format displays numbers with commas. For 
example, 1234 becomes 1,234.00. 

 
The increase decimal button and the decrease decimal 
button control how many decimal points appear aftern 

a number. Typing 1234 then clicking the increase decimal button 
twice results in 1234.00. Typing 1234 then clicking the decrease 
decimal button makes no changes, because there are no decimal 
places to remove. 

Borders and gridlines 
To apply borders or gridlines to cells, first select 
the cell or group of cells. Click on the arrow 
next to the Borders button on the Formatting 
toolbar. Last, select a border or gridline style. 
If you select more than one cell and then apply 
the border, the border will be applied to the 
group of cells you selected — not to each individual cell.  
To remove borders, select a range of cells and then select the no 
borders option. 

Formatting cells 

Pretty colors 
You can also change font 
colors and fill colors using 
the formatting toolbar.  

n To change font color, 
select the appropriate 
cells and click the Font 
Color button. Then 
select the color you 
need. Note: Fonts in 
color are usually easier 
to read if they are also 
in boldface. 

n To change or create a 
fill color, select the cells 
you want to change. 
Then click the paint 
bucket tool and select 
the color you need. 

n Another option is to 
use AutoFormat. Select 
your entire table, then 
Format, AutoFormat. 
You will see a variety of 
formats available; 
double-click the one 
you want to use. 
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Exercise 3: Modifying your 
spreadsheet 

1. Open your budget spreadsheet. 
2. Increase the font size of the title (Budget 1st Q) to 16 and 

make it bold.  
3. Using the Merge and Center tool, center the title (Budget 1st 

Q) which is stored in cell A1 across the columns.  (Select the 
range A1:E1, then click on the Merge and Center tool 
button.)   

4. Make the headings in Row 3 and in Column A bold. 
5. Center the headings in Row 3 and in Column A using the 

Align Tool.  
6. Italicize the totals listed in Row 7 (B7:E7).  Apply the 

currency format to the data in range B7:E7. 
7. Add grid lines to the entire spreadsheet (Range A1:E7).   
8. Save your changes. 
 
 

 



 

 
 
 
 
 
 
 
 

 
 
 
 

 

16 of 18 

 

  

Cut, copy & Paste  

Cut, copy and paste are useful commands that can help you to 
edit and move data around.  These commands are available in 
most programs including Word, Excel and PowerPoint.  
The cut command will let you “cut” data or move the data to 
another location. (Think of scissors cutting a section out of a 
piece of paper).  That “cut” data is stored in the computer’s 
short-term memory.  

To move data using cut & paste 
1. Select the data to be copied. 
2. Click the cut button on the toolbar, or hold down the Ctrl 

key while you hit the x key on your keyboard. 
3. Move your mouse to the data’s new position. 
4. Click the paste button on the toolbar, or hold down the Ctrl 

key while you hit the v key on your keyboard. 
 

The copy command is very similar to the cut command.  
However, instead of moving the data, you make a copy of it and 
place that copy in another location of your worksheet or 
workbook.  This can be very useful when you need to duplicate a 
portion of your spreadsheet and don’t want to retype it.  

To copy data 
1. Select the data to be copied. 
2. Click the copy button on the toolbar, or hold down the Ctrl 

key while you hit the c key on your keyboard. 
3. Move your mouse to the data’s new position.  
4. Click the paste button on the toolbar, or hold down the Ctrl 

key while you hit the v key on your keyboard. 
 

Keyboard 
n Cut      Ctrl + x 

n Copy   Ctrl + c 

n Paste   Ctrl + v 

Toolbar buttons 
n Cut       

 

n Copy   
  

n Paste    
 

Menu commands 
Cut, copy, & paste can all 
be found in the Edit menu. 

 

Tip 
In Excel, a section of a 
worksheet that has been 
cut or copied will display 
with a dotted line border 
around it. When you paste 
the data into another part 
of your worksheet or 
workbook, the dotted line 
will disappear. 
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Final project                        
                     

 1. Create a new workbook by clicking on the New button.  In 
Cell A1 give the spreadsheet the title: “<your first name>’s 
Sales Report.” Then fill in this data: 

 Store A Store B Store C All stores 

CDs 775 600 995  

Videos 550 426 600  

DVDs 360 250 400  

Total     

2. Use AutoSum to get the totals for what each store sold and 
for the numbers of items sold at all stores. (Cells B7, C7, D7, 
E4, E5 and E6.) 

3. Save your workbook and name the file: <your first and last 
name> Sales. 

4. Insert two new rows between 4 and 5 and give them the 
headings Gizmos (Cell A5) and Gadgets (Cell A6). 

5. Add this data in A5:D6 

Gizmos 600 500 400 

Gadgets 400 500 600 

6. Select Row 5 (Gizmos) and delete it. 
7. Use Undo to bring the row back. 
8. Select cell A1, change the font size to 18 and make it bold . 

Select the range A1:E1 and center the heading using the 
Merge and Center tool. 

9. Make Column A and Row 3 bold. 
10.Select the range B4:E9 and give it $ format and add gridlines. 

Remove any decimal places being shown. 
11.Save your work.  
 

Your final product should look like the example on the next page! 
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Final project — check your 
work!                                  


